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Photo/Graphic Edges are special effects that can easily be applied to a color or grayscale image to make it really look distinctive. These edge effects
can help enhance the tone and feeling of an image by giving the photo added dimension and character. With Photo/Graphic Edges you never have
to do a square design again! Works with any image - regardless of resolution, size or proportions.

This easy to use plug-in lets you control the edge sizes, orientation, softness, feather, borders and can quickly preview the effect before applying it.
Photo/Graphic Edges also lets you combine different edge effects to create your own unique look - mixing and matching within the same or
between volumes - you can even add colors to the borders and the backgrounds behind the effect for unlimited variations. You can have bordered
effects as shown in the examples above or you can have borderless effects where the image seamlessly blends into the entire edge shape.

Each volume lets you create thousands of uniquely crafted edge effects and comes with a complete catalog of effects and full color manual. There
is no question that these effects will quickly become one of the most powerful design tools in your arsenal!

Photo/Graphic Edges™ Volume I - Traditional Edge Effects
A collection of thousands of traditional types of edge effects including deckled, ripped, semi-transparent, film strips, film frames (2 1⁄4 & 4 x 5),
emulsion transfers and other classic darkroom styled effects. A very classy collection for any type of design project.

Photo/Graphic Edges™ Volume II - Geometric Edge Effects
A collection of thousands of distinctive geometric edge shapes, abstracts, impressionistic and powerful new digital edge effects. This collection is
perfect for adding shape and dimension to your images.

Photo/Graphic Edges™ Volume III - Artistic Edge Effects
A collection of thousands of hand painted edge effects. These effects were created using practically every painted and mixed medium: watercolor
fadeouts, brushed acrylics and oils, rubbed charcoal, splattered airbrush, etched scratchboard, etc ... and offers a large variety of brush strokes,
different edged techniques, styles and tones. Perfect for adding a little artistic flair to any project.

Sample Edge Effect
The edged lion images below were created using the two free sample edge effects provided with this demo software. An Inset Scale of -10 was
used to create the black border around the lion. Our full version products are available from most US and international mail order catalogs or can
be purchased directly from Auto F/X by calling 800-839-2008. See our website for more free demo software at http://www.autofx.com.

AF321.afx - Sample from Volume I AF263.afx - Sample from Volume III
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United States Patents Pending

Install Instructions
Photo/Graphic Edges 3.0 works as a Photoshop 3.0 compatible plug-in and supports all 
applications that follow these standards.

Memory Requirements:
Macintosh: Photo/Graphic Edges gets its memory from free RAM outside of the host application.
It is important to leave at least 6MB of free RAM on your system. For larger high-res images
(8x10 @ 300PPI or higher) leave around 12-15MB of RAM free outside the host application if
possible. This ensures a faster and higher quality effect.

Windows: Photo/Graphic Edges gets its memory both from RAM and Virtual memory from your
startup system hard drive. It is helpful to set the RAM allocation of the host application a little
higher than normal while running this software to optimize the performance. Photo/Graphic
Edges requires lots of scratch disk space while working with images. It always gets the scratch
disk space from the startup system disk and needs between 4-6 times the target image size free
in order to process the effect so make sure you have extra hard disk space available before apply-
ing an effect.

Choose the Application:
To install Photo/Graphic Edges, you must first decide which image editing, page layout, or illus-
tration application will host the plug-in. The application must support the Photoshop 3.0 SDK
standard for plug-in filters. See the host application manual or call their tech support if you are
not sure if it supports this standard.

To Install Photo/Graphic Edges:
We have optimized this plug-in for Macintosh and Windows systems so you can get maximum
speed and performance. The install program automatically detects your hardware type and oper-
ating system and installs the appropriate version of the plug-in on your system. Before you begin
the installation process quit all running applications. Insert the Photo/Graphic Edges CD-ROM
disc that came with your manual into the CD-ROM drive.

• On a Macintosh, double-click on the install file on the CD to begin the installation.

• On Windows 95/NT double click on the ‘My Computer’ icon located on the desktop. Find the
CD-ROM icon inside the ‘My Computer’ directory and double click on it. Locate and 
double click on the Setup icon to begin the installation.

Select the appropriate folder or directory for your application’s Photoshop compatible plug-ins.
Follow the onscreen instructions to complete the installation. Photo/Graphic Edges should
appear in the menu where Photoshop plug-ins reside. Depending on the host application you are
using you may have to identify the folder or directory where the plug-in resides. Consult the host
application’s manual or call their tech support if you need further assistance in 
determining where Photoshop plug-ins go and how to access them.

Visit Our Website: http://www.autofx.com
The Auto F/X website has tips on using this software, designer resources, beta tests on

new versions and software, updates, special promotions and links to lots of cool sites.
Come visit us today and see for yourself!



The Basics
Photo/Graphic Edges (PGE) works as a plug-in. Your application must support Photoshop 3.0 plug-ins for it to work. In an image
editing program you must open an image and can either have part of the image selected or can apply the effect to the entire photo.
In a layout or illustration program you must have placed an image and have the picture box selected for the plug-in to be available
in the plug-ins menu.

Choose an effect from our Catalog of Effects and use the PGE plug-in to fuse your image into the edge shape. The edge will shape
itself to the proportions of your file (i.e. a square edge effect applied to a rectangular photo will be resized to become rectangular).
Use the controls described on these pages to alter and modify the edge effect to your satisfaction. As there are numerous key 
combination controls that offer you more options and precise control over items such as scaling direction and sharpness, we 
recommend you read the Control Options chart on page 3 in this manual carefully.

How to Quickly Create an Effect
There are two basic types of edge effects: An Outset and an Inset effect. An Outset effect is one where the entire image is fused into
the shape of the edge effect and seamlessly bleeds to the very edge of the effect. An Inset effect leaves a border around the image.
Note: You must first apply an Outset effect before applying an Inset effect.

To apply an Outset effect you click on the Select Outset Effect button and choose an edge from the Edges 
folder located in the Auto F/X > PGE > Edges folder inside the host applications plug-in folder.
Note: Clicking Option (Mac) or Alt (PC) removes the Outset & Inset.

Applying an Inset Effect. After you have chosen an Outset (outer shape) for your effect you can then add a border around the
edge. This helps add definition around lighter images and also serves to draw attention to the
image by giving it an edged frame. There are two ways you can apply an Inset effect to your
image. The first way is after an Outset effect is selected and shows up in your preview window, go to the Inset Scale slider and
move the button control to the left. This will create a uniformed border around the image in the shape of the Outset effect. 

The second method of applying an Inset effect is to click on the Select Inset Effect button and pick a new
edge to use as the inset. Most insets that you choose using this method will need to be scaled to fit the Outset

effect. Some edges are so different from each other that they simply don’t work well together. You should select Inset edge effects
which are relatively the same geometric shape as the Outset effect to get the best results. Note: You cannot select the same edge
for both an Inset and Outset effect. Some really cool effects are possible by mixing edges from different volumes. If you own more
than one volume try combining an Outset from one with an Inset from another.  For example, a transfer Outset from Volume I 
combined with a rubbed charcoal styled edge from Volume III looks great! You can use the flip, rotate and scale controls to 
independently adjust the attributes of both the Outset and Inset edges to meet your satisfaction so almost any two edges can be
combined together.1

No one likes reading a manual - so use these quick start pages to get up and running fast!



How Can I Magnify the Preview? To zoom in on the effect and view greater detail move the cursor
over the preview window and over the desired area. Clicking while pressing Option (Mac) or Alt (PC)
zooms out again. Command (Mac) or Control (PC)  clicking brings you back to the original miniature

preview. Keep in mind that the operations our software performs to build a preview are extremely complex and
building a zoomed in preview may take quite a while. The default preview size which is zoomed all the way out
is the fastest and easiest way to work.

What Does the Inset Scale Slider Do?. The Inset Scale slider controls the
scale of any Inset effect. It will proportionally constrain the scale if no modifi-

er keys are used. If you hold down the Option (Mac) or Alt (PC)  key while working the slider the Inset is scaled
in a vertical direction. If you hold down the Command (Mac) or Control (PC) key and work the slider the Inset
is scaled in a horizontal direction. These controls are useful when an Inset edge does not proportionally fit the
Outset and needs to be independently scaled in either a horizontal or vertical direction.

What Does the Inset Blur/Sharp Slider Do? The Inset Blur/Sharp slider
controls the softness or sharpness of any Inset edge effect. It can help soften the

transitional merge of the Inset border and the photo it contains into the outer border by feathering the edges of
the inner photo into the outer border. If you hold down the Option (Mac) or Alt (PC)  key while working the
Blur/Sharp slider it will sharpen the inner edge border.

What Does the Outset Scale Slider Do?. The Outset Scale slider controls
the scale of any Outset effect. It will proportionally constrain the scale if no

modifier keys are used. If you hold down the Option (Mac) or Alt (PC)  key while working the slider the Outset
is scaled in a vertical direction. If you hold down the Command (Mac) or Control (PC) key and work the slider
the Outset is scaled in a horizontal direction. These controls are useful when an Outset edge needs to be inde-
pendently scaled in either a Horizontal or Vertical direction in order to better fit the crop of the photo.

What Does the Outset Blur/Sharp Slider Do? The Outset Blur/Sharp slider
controls the softness or sharpness of any Outset edge effect. This can help soft-

en the Outset border and the photo it contains into the background by feathering the edges. You should first
scale the Outset effect smaller using the Outset Scale controls if you plan on softening the Outset very much.
Scaling the Outset smaller leaves room for the feathering to take place - otherwise you might feather the image
off the live area of the file and it will not look correct. Hold down the Option (Mac) or Alt (PC) key while work-
ing the Blur/Sharp slider to sharpen the Outset. 

What Does the Background Color Button Do? The Background Color button lets you
fuse a color behind the Outset edge effect. This is useful if you want to place your edged

artwork over a process colored background in your host application or to match a website background color. You
use the application’s color picker to set the background colors to match the exact RGB or CMYK * settings you
will use on the background color in your host application or website page - this way the edge’s background color
matches the background color in the host application it is layered over. Note: Onscreen colors may look 
different due to the fact that the edged image color is displayed onscreen differently than colors drawn by 
the host application. If both colors are set to match they should output to film with no seams.

What Does the Edge Border Color Button Do? The Edge Border Color button lets you
color the border that is created when you are working with an inset effect. This is useful to

add interest and variety to the borders themselves. You can also match the border color with a color selected from
your image for a complimentary and balanced look.

* If the host application does not support a color picker the system color picker will be used. CMYK settings
are not available using the system color pickers.

Original Image

Outset Effect Applied

Inset Scale Applied

Edge Border Color Applied

Outset Blur Applied Mixing Insets & Outsets Transparent BackgroundBackground Color Used



Outset Rotated Clockwise

Note how the same edge
rotated looks totally different!

How Can I Rotate an Edge Effect? You can easily rotate the orientation of the edge effect by
clicking on the Rotate button at the bottom left side of the preview window. Clicking on
the button without any modifier keys will rotate both the Outset and the Inset (if you

have selected an Inset) in a clockwise direction each time it is pressed. If you Option (Mac) or
Alt (PC) click on the Rotate Button only the Outset will be rotated. If you Command (Mac) or
Control (PC) click on the Rotate Button then the Inset edge will be rotated.

How Do I  Flip or Mirror an Edge? You may, at times, like to have the left edge applied to
the right side of an image - instead of on the left. You can easily achieve this effect by
using the Mirror Buttons (located on each side of the preview window) which flip the
orientation of the edge - reversing top and bottom or left and right sides with each other.

If you press the Mirror Button without pressing any modifier keys then both the Outset and
Inset (if you have selected an Inset) are flipped together. If you Option (Mac) or Alt (PC)  click
on the Mirror Button only the Outset edge will be flipped. If you Command (Mac) or Control
(PC) click on the Mirror Button then only the Inset edge will be flipped.

BUTTON & SLIDER CONTROLS

Inset/Outset Scale
No keys Scales both the horizontal and vertical sides of an edge effect
Option (Mac) or Alt (PC) Scales the edge inward or outward in a vertical direction only
Cmd (Mac) Ctrl (PC) Scales the edge inward or outward in a horizontal direction only

Inset/Outset Blur/Sharp
No keys Softens the edge effect
Option (Mac) or Alt (PC) Sharpens the edge effect

Select Inset/Outset Effect
No keys Allows you to select an edge effect to be applied to the image
Option (Mac) or Alt (PC) Removes the Outset and/or Inset effects

Background Color
No keys Allows you to select a process color to be used behind the effect
Option (Mac) or Alt (PC) Makes the background transparent (works only on transparent layers)
Cmd (Mac) Ctrl (PC) Makes the background solid white

Edge Border Color
No keys Allows you to select a process color to color the edge border
Cmd (Mac) Ctrl (PC) Makes the edge border black

Rotate Button
No keys - Rotates the Outset and the Inset (if one is chosen) clockwise
Option (Mac) or Alt (PC) Rotates just the Outset clockwise
Cmd (Mac) Ctrl (PC) Rotates just the Inset clockwise

Mirror Buttons
No keys - Flips the Outset and the Inset edges in the opposite direction
Option (Mac) or Alt (PC) Flips the Outset edge in the opposite direction
Cmd (Mac) Ctrl (PC) Flips the Inset edge in the opposite direction

Zoom Tool
No keys Zooms closer to the area over which it is clicked
Option (Mac) or Alt (PC) Zooms back from the area over which it is clicked
Cmd (Mac) Ctrl (PC) Zooms all the way back to a full preview sized window
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Layering Edges Over Other Images or Backgrounds
Using an image editing application that supports transparency, you can make the area surrounding
your effect transparent so that the edge effect and image inside it may be layered or collaged over
other artwork. This is useful as you cannot take an edge effect created with a white or colored back-
ground and place it over an image in a layout or illustration program without getting a white fringe
around the edge (even if the layout program sets the background colors to none). This shortcoming
is due to the complex masking necessary to merge two separate images together and the inability of
most layout and illustration programs to handle such tasks. If you want to layer the edge over a solid
or screened background process color use the background color option our software gives you. If you
want to layer the edge over another image or a gradient, use the transparent feature described below.

We have have built in a transparent background feature that works when you are in any application
that supports transparency. This includes Photoshop 3.0 and higher and Corel Photopaint 6.0 and
higher. To activate the transparent background feature you must have a photo pasted onto a trans-
parent layer and have it selected with a rectangular selection marquee. When you activate our filter
it should detect the transparent layer and upon selection of an Outset effect make the areas around
the edge effect transparent so you can layer other objects under the effect.

In Photoshop 3.0 or higher you can use a shortcut to make a photo on a background layer assume
transparent qualities. Simply open the photo and get the layers palette on screen. Double click on
the name: Background on the layers palette and rename it. Activate our plug-in and choose an Outset
effect. The transparent checkerboard pattern should show around the edges indicating that it will
apply transparency around the edge effect. You can then either drag the layer over another Photoshop
file and it will copy onto the file as a new layer or you can select the entire edged image and copy
and paste it onto a new layer in another file. Remember that if you are working in Photoshop 3.0
and higher you must save transparent files using the Save A Copy Command. You should also save
a copy of the file as a 3.0 or higher native file format so you can go back and make changes to the
layered artwork as desired.

Creating a Quick Drop Shadow Behind Edges Using Photoshop 3.0 or Higher
You can help the edge effect have additional interest by adding a simple drop shadow to the effect
in Photoshop. To do this you will want to make the background behind the edge effect transparent
(see Layering Edges Over Other Images or Backgrounds above). There are lots of different ways to
create a drop shadow - here is our favorite because it is quick and relatively easy to complete:

1) Once the effect has been applied and you have a transparent area around your edged photo get the
Layers palette onscreen by going to the Window > Palettes > Show Layers command. 

2) Duplicate the layer your edged image is on by dragging the layer over the page icon at the 
bottom of the layers palette or by pulling down the Layers Arrow at the top right of the palette and
choosing Duplicate Layer. Drag the duplicated layer under the original image layer. 

3) With the duplicate layer highlighted and under the original layer you will next want to check the Preserve Transparency box
which is located on the Layers Palette. Next you need to color the shadow by setting the top or Foreground color chip on the
Photoshop tools palette to the desired color and then applying the Edit > Fill command to fill the shadow with the Foreground
Color at 100% Opacity and Normal Mode. Because the layer has the Protect Transparency option checked the color will only fill
into the pixels on this layer and not into any transparent areas.

4) You should now offset the shadow so it is not directly under the edged image. Before you do this, however, you must uncheck
the Preserve Transparency box on the Layer’s Palette. You can offset the shadow  by selecting the Layer Move Tool (looks like a
four pointed lug wrench). Take this tool and click anywhere on the layer and drag the shadow to offset it.

5) After the shadow is offset you want to blur it to give it a soft look. Use the Gaussian Blur Filter located under the Filter menu .

6) If you want to merge both the edge and the shadow layer together use the Layers Palette pull down menu command > Merge
Layers and both the shadow and the edge layers will fuse into one layer. This new layer can then be pasted over any image and the
shadow will blend into it. Cool!

Edge Over a Color Split

Edge Over an Image

Edge Over a Gradient
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How to Capture The Right Look
As Photo/Graphic Edges can help you capture the look and feel of an image you should pay 
special attention to the image tone. Be sure to consider what the subject matter is and how it is
presented in the image. If the image is soft and gentle looking, use an edge which adds to this
by giving the image a soft and gentle or artistic edge - don’t use an edge which speaks of action
or energy. You can also try using a color around the edge of an image. By selecting a color that
is found in the image itself you can forge a common element between the edge and the image.

Edges tend to attract attention and add interest to images. This is caused by an interesting 
reaction of the eye and mind to abstract shapes. An edged image compared to a normal image
can capture the viewer’s attention for a longer time due to the distinctive shapes it gives an
image. You can overkill this effect by adding too many edges to your project. If everything has
an edge it may be too much for the viewer to take in. As with any design technique - use edges
with good judgement and sparingly for the best results.

Adding a Glow Like Effect Around Your Edge
Sometimes you will notice that when you apply an Outset effect to an image that has light areas
or areas with little color or detail that the edge gets lost or drops out in these areas. To help 
compensate for this or to add a different look to the effect you can create a soft glow around the
edges by using the technique described below.

1) Apply an Outset effect to your image

2) Use the Inset Scale controls to reduce the size of the Outset frame and to leave a border around
the image. The border can be as large or small as you desire. Usually a setting of around 
-6 to -12 works for most images.

3) Change the border color to the desired setting by clicking on Edge Border Color.

4) Apply a blur to the Outset border using the Outset Blur/Sharp slider.

You will notice that your inset border is sharp and is now surrounded by a subtle glow like effect
from the Outset border. You can scale the Outset border using the Outset Scale slider to adjust
the positioning of the border. You can also try using a lighter or darker border color to vary the
intensity of the glow effect. Try using the same technique but in reverse to blur an Inset effect
into an Outset border. The Inset will feather into the sharper outset shape. Cool!

Transfer Effect AF320.AFX
from Volume I

AF320.AFX & Original
Image Merged As Outset

Original Image
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By blurring the Outset and keeping the
Inset sharp you can simulate a glow

around the edge effect. 

This technique can help edges show up
better against lighter backgrounds.

Apply Photo/Graphic Edges to
Textures and Artwork
Try applying Photo/Graphic Edges
to textures and artwork to create
unique backgrounds for blocks of
type, clipart and logos.

Remember that the main purpose of
Photo/Graphic Edges is to help
breakup the uniformity of images
and to help add interest to anything
you might be working on.

The single largest collection of textures
on the planet. Plus a cool plug-in that

fuses textures into your layout!



Types of Programs Supported
Photo/Graphic Edges works with any host application which fully supports the Adobe Photoshop 3.0 plug-ins SDK.

Accessing The Plug-in
Photo/Graphic Edges can be accessed by any application that supports Photoshop 3.0 plug-ins. You must either place a copy of
the Photo/Graphic Edges plug-in in the host applications’ plug-ins folder before launching the application or set the plug-ins 
preferences for the host application to the location where you have Photo/Graphic Edges installed on your computer. Each 
application has a different setup required for where you put the plug-ins. Refer to your host application’s manual for more details.

Removing The White Fringe Around An Edge
If you are trying to layer an edge effect with a white background over another image, color or gradient in a layout or illustration
program you will notice that there will be a fringe of white around the edge effect. Refer to Layering Edges Over Other Images
or Backgrounds on page 4 of this manual for information on solving this problem.

Target Image Color & File Type Support
Photo/Graphic Edges can only be applied to CMYK, RGB & Grayscale images. If you are working with any other color mode
(including duotone) change the file to an RGB image in your image editing application and apply the effect. Convert the file back
to the original color mode after it has been edged. Photo/Graphic Edges will work with any file type supported by the host 
application including TIFF, EPS, JPEG, PICT, BMP and PCX files.

Out of Memory Alerts
The only time you should get an out-of-memory alert is when you are out of hard disk space. Photo/Graphic Edges always uses
the startup system drive for scratch disk space. If you run out of scratch disk space you can either make room on the startup drive
or restart from a larger hard drive. You should have around 4-6 times the target image size available in hard disk space before 
trying the effect again. You can also try allocating more RAM to the host application.

Support for Background & Edge Border Colors
The Photoshop SDK standard which the Photo/Graphic Edges software is written to does not currently allow for support of 
spot colors. At the present time there is no way to specify a background or edge border color to be a spot color. In some host 
applications a color picker is not made available to our plug-in. In such cases the system color picker is used.

No Edge Effect Is Showing In The Preview Window
You must first select an outset edge effect before you will see an edge in the preview window. You may also have scaled the Outset
or Inset effect too large - making the edge bleed off the live area.

Custom Edges & Older Version Edges from Photo/Graphic Edges Are Not Supported
The Photo/Graphic Edges 3.0 plug-in will only support the edges included on the CD-ROM that came with the software. Earlier
versions of our edge effects (version 1.0 & 2.0) or custom edges are not supported.

Background and Edge Border Color Options Are Not Available
Some host applications do not offer the color services we require to be able to offer you the ability to change the background color
from the default setting of white and the edge border from the default setting of black. Try using a different application.

Working With Irregular Shaped Images
Photo/Graphic Edges can only work with rectangular or square images or selections. If you are working on an image on a 
transparent layer the image itself may not contain transparency.

Problems Outputting Edged Files
You should never encounter printing problems after using our software as it does not alter the file in any way other than to remove 
pixels in areas around the image. Most printing problems are solved by opening and resaving a file as a different format (EPS,
TIFF, etc...) or by updating printer drivers so they are current with updated system software or applications.

Getting Technical Support
Tech support is reserved for registered users only - as this demo is free and is widely distributed in numerous countries we can-
not offer technical support for it.
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